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WARNING
	 Make	 sure	 you	 download	 any	 pictures	 from	 your	 camera	 BEFORE	 removing	

or	 changing	 batteries,	 unless	 you	 have	 been	 using	 an	 SD	 card	 rather	 than	 the	
internal	 memory	 for	 photo	 storage.	We	 recommend	 you	 download	 all	 current	
photo	 files	 for	 safekeeping	 before	 storing	 the	 ImageView	 away	 if	 you	 are	 not	
using	 an	SD	card	 in	 the	 camera,	 in	 case	 the	batteries	become	depleted	during	
extended	storage.	

WARNING
Do	NOT	look	directly	at	the	sun	through	your	binoculars.

Doing	so	may	cause	permanent	eye	damage.

NOTE: To reset the camera if you experience problems or if the display becomes 
unresponsive, remove the batteries for at least one minute, then re-install them. 

This may result in the loss of photos/videos stored in the internal memory.

English
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Congratulations	 on	 your	 purchase	 of	 the	 Bushnell	 ImageView®	

binocular!	 The	 Bushnell	 ImageView	 binocular	 takes	 the	 technology	

of	digital	photography	and	combines	 it	with	a	high-quality	 compact	

binocular.		This	allows	you	to	observe	sporting	events,	wildlife,	scenic	

vistas	or	anything	you	would	normally	use	a	binocular	 for,	and	then	

save	 the	 image	 in	 a	 built-in	 attached	 digital	 camera.	 	 You	 can	 then	

download	 these	 images	 to	 your	 computer	 and	 e-mail	 them	 to	 your	

friends	and	family,	print	out	the	picture	using	the	included	software	or	

save	them	in	a	photo	album	for	future	use.	Before	using	the	product,	

please	 read	 the	 instructions	 contained	 in	 this	 manual	 and	 take	 time	

to	 familiarize	 yourself	 with	 the	 different	 parts	 and	 features	 of	 the	

product.
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CAMERA PARTS

1. The camera is powered by two AAA alkaline, lithium, or NiMh batteries (not included). 
insert batteries into the compartment, with the springs in contact with the negative (flat) end 
of each battery. A power meter on the lower right of the display indicates battery condition.
2.  insert an SD card ("upside down" with metal contacts facing up) in the slot if greater 
storage is desired. You may use SD cards (not MMC cards) up to a maximum 1 GB capacity. 
The camera has 16 MB of internal memory which can hold over 100 photos, so a card may not 
be necessary. However, the internal memory contents will be lost if the batteries are removed or 
die-unlike photos stored on an SD memory card. A 256MB, 512 MB or 1GB standard speed 
SD card is available in most consumer electronics or computer stores and a is good choice for 
your imageView, especially if you will always use "Hi" resolution.
3. Press and hold the MODE button until the power LED comes on. The camera will turn 
off automatically after about one minute if no buttons are pressed. Note: when the camera is 
connected to a computer via the supplied USB cable, the camera will power on automatically, and 
draw power from the computer with no battery drain.
4. Hold the imageView steady and press SNAP to take a picture (or start/stop shooting a 
video, when the camera is in video mode). The camera focus is preset to take sharp photos from 
appoximately 35 feet to infinity.
5. When using a tripod, you can help avoid the effects of camera shake by plugging the 
supplied remote shutter release into the jack next to the SD card slot, and using the button on 
the remote rather than SNAP to take photos. 

Setup	and	Basic	Operation
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The imageView will imprint the date and time in the bottom right corner of your photos. to 
set the correct date and time, after turning on the camera, press and hold both the MODE and 
SNAP buttons at the same time, until the display begins to flash. The display now shows the 
last two digits of the year. Press the MODE button to move the cursor to the second digit if 
necessary. Press the SNAP button to advance the digit to the current year ("07" for 2007, etc). 
Then press MODE to go to the next number, which is the month. Again, use SNAP to change 
this to the current month. Following the month display is: date, hour (24hr format), minute, 
and second-continue to set these following the same process using the MODE and then SNAP 
buttons. When you have completed all of the date/time settings, the display will stop flashing 
and return to normal.  Note that you will need to reset the date/time after replacing batteries.

Your imageView is already set to high resolution and quality right out of the box, and it is 
not necessary to use the MODE settings and make any changes to get good results by simply 
pressing the SNAP button to take photos. However, as you might want to shoot a video clip, 
delete one or more previous photos, or explore other options, we recommend you review the 
available mode options listed on the following pages. Briefly pressing the MODE button will 
step through these operational modes in the listed order, and you will see the icon for each 
mode along with its current setting on the display. Use the SNAP button to select the desired 
setting for any mode. if you make no changes, and the SNAP or MODE button is not pressed 
within 5 seconds, the camera will return to normal operation and display. 

Using	the	Operational	Modes/Setting	Date	&	Time
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Mode Icon Settings Description

Video Video 
Camera

OFF, ON Select "ON" instead of "OFF" to put the camera 
in video mode. Wait several seconds for the camera 
to automatically return to the normal display, then 
begin shooting by pressing SNAP. The counter 
will show elapsed time. Press SNAP again to 
stop shooting. The counter will advance by one, 
indicating the video file has been saved. Return to 
the video mode setting and select OFF to reset the 
camera to still photo mode. 

Quality Hq or Lq High, Low Select "Hi" (recommended) or "Lo" quality to 
choose the amount of file compression, which affects 
the size of the photo file. "Lo" allows more photos 
to be stored in memory, but at reduced quality.

Resolution Hi or Lo High (2.1mega 
pixels), Low 
(640x480 pixels)

Select "Hi" (recommended) or "Lo" resolution, 
based on your preference for better looking photos 
(Hi) or being able to take a greater number of 
photos (Lo).

Using	the	Operational	Modes  (Bold indicates default settings)
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Mode Icon Settings Description

Line Frequency 60 or 50 60 Hz, 50 Hz Set to match the AC power frequency (cycles) of 
your country. This ensures that stills and videos shot 
under fluorescent lighting appear normal.

Continuous Ct OFF, 3, 5 Select 3 or 5 frames to shoot a rapid series of photos 
instead of a single frame when SNAP is pressed 
(in normal still photo mode). to cancel, enter this 
mode again and select OFF.

Memory Access MEM Sto (USB Mass 
Storage), PC (USB 
Camera)

Select "Sto" to access the internal or card memory 
when the camera is connected to a computer with 
the USB cable. "PC" allows the camera to be 
used as a live USB/PC camera (note that the 8x 
magnification and lack of close focus capability 
limits usefulness in most size rooms)

Delete Last LSt+trash 
Can

None-press SNAP 
to delete the last 
photo or video

Select this mode and press SNAP to delete only the 
last photo or video you took. The counter will go 
down one number.

Using	the	Operational	Modes
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Mode Icon Settings Description

Delete All ALL+trash 
Can

None-press SNAP 
to delete all photo 
and video files

Select this mode and press SNAP to erase the entire 
memory contents (the counter resets to zero). 
Use this after downloading your files, to clear the 
memory so you can take new photos. if "Delete All" 
is selected accidently, simply wait a few seconds and 
the camera will return to normal operation.

Format For+trash 
Can

None-press SNAP 
to format card or 
internal memory

if you are using a new SD card, or one previously 
used in other devices, we recommend you select 
Format and press SNAP before you start taking 
photos, to the card is setup with the correct data file 
system for this camera. Note that formatting a card  
erases its contents-please be sure you have backed up 
any previous files first.

Self-timer Clock OFF or On Photo is taken after a 10 second delay when SNAP 
is pressed (in normal still photo mode.) This can be 
used to avoid accidently shaking the camera when 
the SNAP button is pressed. if the remote shutter 
cable is available, it should be used instead of the 
self timer when the camera is tripod mounted. The 
timer automatically cancels after use.

Using	the	Operational	Modes
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USING	THE	IMAGEVIEW	WITH	YOUR	COMPUTER:

1. the camera will be recognized as a USB mass storage device (if it is set to "StO" and not "PC"), 
which means no special drivers are required for all operating systems later than Windows 98 (Me, 
2000, XP, Vista.) Mac OS 9 and OSX are also compatible. if you have a PC running Windows 98, 
you must install the driver found on the included CD-ROM BEFORE CONNECtiNG tHE 
CAMERA tO YOUR PC. 

2.  if you have a computer OS as listed above that is USB mass storage compliant, a new disc icon will 
appear in Windows Explorer (under “My Computer”) as a new “Removable Disc” after plugging in 
the USB cable from the imageview. Mac users will see the new disc device appear on their desktop. 
Clicking on the new disc icon will show the contents, a folder named “DCiM.” the image folder 
inside this contains your photos, stored as JPEGs (.jpg file format). they may then be viewed, 
edited, renamed and saved using any photo or graphics software that accepts .jpg files. if you do not 
have software that will open .jpg files, you should install Roxio Photosuite 5 (Windows 98, 2000 or 
XP only) from the included CD-ROM. See “Software installation” for instructions.

3. After you have copied or opened and saved the photo files to your computers hard drive, you 
may disconnect the imageview camera (NEVER disconnect the camera while files are still being 
transferred to your computer.) Before disconnecting, you should “eject” or stop the "removable disc" 
representing the camera to avoid an error message (not necessary with Windows XP). 

4. See the following pages for full step by step instructions to download your photos. 
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System Requirements (Minimum)

Software Installation 

Transferring The Photos & Videos to Your PC - Step by Step

OS: Windows® 98/98SE/2000/ME/XP/Vista (PhotoSuite 5 is not compatible with Vista)
CPU: MMX Pentium® 200MHZ equivalent or faster (Pentium® iii 500 MHz for PhotoSuite5™)
Memory: 32MB minimum (64MB recommended for PhotoSuite)
SVGA video card w/2MB VRAM, 800x600 screen display, 16 bit High color
200 MB available hard disk space (if installing PhotoSuite)
internal USB Port

if you are using Windows 98, you must install drivers before connecting the camera to your PC. insert the CD-ROM 
into your computer’s CD drive; it will auto-run and the install screen will be displayed. Select “install Driver”, then 
follow the directions. After installation, restart your computer. Windows 2000, ME, and XP do not require drivers, 
as the camera uses the USB mass storage standard , allowing the photo files to be accessed as if they were stored on 
an external hard drive. For any Windows OS, if you are not already using photo editing software you prefer, you may 
install Roxio PhotoSuite® from the CD-ROM. Be sure to read the “Release Notes” completely, noting any tips or 
potential issues relevant to your PC configuration and OS.

1. Be sure the driver has been installed first if you are on Windows 98/98SE.
2. Connect the supplied cable to the imageView’s USB port, then directly to a main USB port on your computer-do 
not use front panel/keyboard USB ports or unpowered “hubs”.

CAUTION:		Make		sure	you	download	all	photos/videos	from	your	
																				camera's	internal	memory	before	removing	the	batteries.

Note: With Windows Vista, you may encounter error or warning messages (“file missing”, etc) while 
installing PhotoSuite 5, but clicking “OK” and proceeding should allow the installation to finish. 
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Transferring The Photos & Videos to Your PC  continued
3. The LCD display will indicate “StO”, and the imageView will be recognized as a standard “USB 
Mass Storage” device. This means that the camera files can be easily viewed, edited, or copied to your 
hard drive, just as if they were stored on an external hard drive or a CD-ROM. (Note for Mac users: you 
may need to select "StO" memory access and plug in the imageView while its LCD still displays "StO" 
for it to appear on the Mac desktop as an "Untitled" disk. See "Using the Operational Modes")

4. (This step is not required with Windows XP, simply use the options in the pop-up window to view, copy 
or edit your photos). Open My Computer or Windows Explorer. The camera will be seen as a new 
“Removable Disk” with an unused drive letter assigned to it. Double click this new “Disk” icon, open 
the “DCiM” folder inside, then the folder(s) inside that (“100MEDiA” ,etc). Your photos/videos are 
the files inside-they have the prefix “DSC” followed by a 4-digit number, as seen earlier on the camera’s 
display when you review photos. Single clicking any file should show a small preview image.

5. Click “Edit>Select All” (or click on one photo, contol+click to select multiple photos), then 
“Edit>Copy to Folder” (in Windows menus). Select an existing folder on your hard drive, such as “My 
Pictures”, or create a new folder (“Hawaii Vacation”, etc), then click “OK” to transfer copies of the 
photo files you want.

6. After the photos are transferred to your hard drive, you can disconnect the camera. Windows 2000 
may produce a screen warning that you have disconnected a USB device without stopping or ejecting 
the “disk” first (your photo files will not be harmed). if so, check the box that adds an icon to your 
system tray or taskbar.  Then next time you finish transferring photos, you can click that icon first, and 
“Stop the USB Mass Storage Device” before disconnecting the camera. (On Mac computers, you should 
“eject” the untitled “disk” that appeared on your desktop when the camera was connected.)
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Transferring The Photos & Videos to Your PC continued 
7.  You’re now ready to open the photo files in any photo editing software. Just use File>Open and go to the folder 
where you stored the photos earlier. if you are using PhotoSuite, select File>Open Photo, then use the “Look in” 
pull down menu at the top of the Open window, select “My Computer”, select your hard drive, and double click 
any photo in the folder where you copied the files from the camera. it is also possible to open and work with your 
photos directly from the imageView while it is still connected.to do this with PhotoSuite, first follow steps 1-3, 
then open PhotoSuite, select File>Open Photo and use the “Look in” menu to select My Computer, then select 
the “Removable Disk”, and open the folders inside until you get to the JPEG photo files. if you choose to work 
this way, from a connected camera, be sure that you save the photo (when you are done editing) to your hard drive, 
and not the camera’s memory or card. to do this in PhotoSuite, after clicking “Done”, answer “Save Changes?” 
with “Yes”, but then answer “Replace Existing File”? with “No” and use the “Save As” dialog box to save the edited 
photo in a folder on your hard drive (“Save in>Local Disk”), not the “Removable Disk” (camera). 

8. if you are new to photo editing on a computer, consult your software’s Help menu (PhotoSuite has extensive 
built-in Help) for tips on using its features. Along with adjusting the brightness, contrast, sharpness and color 
of your photos, you can resize the photo to fit the paper if you are printing, or save a smaller, low or medium 
resolution version for email or inserting into documents. When you are ready to save your edited file, you may 
want to use “Save As” and give it a more descriptive name than “DSC___”. Doing this also preserves the original 
file as a backup to reopen and re-edit later.  Make sure you have successfully transferred all the photos you wanted 
to save before using “Delete All” on your camera to make room for new images.

ImageView 118322 English+Spanish13   13 11/13/07   8:06:41 PM



1�

	BINOCUlAR	INSTRUCTIONS
 
Your Bushnell binocular is a precision instrument designed to provide many years of pleasurable 
viewing. this portion of the booklet will help you achieve optimum performance by explaining how 
you can adjust the binocular to your eyes, and how to care for this instrument. Read the instructions 
carefully before using your binocular.

EYE	ADJUSTMENTS	(Figure	1)
How to Adjust For Distance Between Your Eyes
the distance between the eyes, called “interpupillary distance,” varies from 
person to person. to achieve perfect alignment of lens to eye, follow these 
simple steps.
   
1.  Hold your binocular in the normal viewing position.
2.  Grasp each barrel firmly. Move the barrels closer together or further apart 

until you see a single circular field. Always re-set your binocular to this position before using.

How to Adjust For individual Eye Strength
As individual eyesight varies from one person to another, most Bushnell binoculars have a diopter setting 
feature which allows you to fine-tune the binocular to your vision. Follow the focusing instructions below 
for your type of binocular.

iNtERPUPiLLARY 

DiStANCE

Fig.	1
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FOCUSING
1.  Adjust interpupillary distance. (Figure 1)
2.  Set the “diopter setting” (Figure 2) to zero and view a distant object.
3.  Keep both eyes open at all times.
4.  Using a lens cover or your hand, cover the objective (front) lens of the 

same side of the binocular that has the “diopter setting.” this is usually 
the right side. (the left side on zoom models.)

5.  Using the center focus wheel, focus on a distant object with fine detail 
(e.g., brick wall, tree branches, etc.) until it appears as sharp as possible.

6.  Uncover the objective lens on the diopter side, cover the other objective lens, then view the same object.
7.  Using the “diopter setting” adjustment ring, focus the same object being viewed. Caution should 

be used as over turning or forcing the diopter eyepiece can cause damage or cause the eyepiece to 
break away from the chassis.

8.  Your binocular should be adjusted for your eyes. Focus at any far or near distances can now be 
attained simply by turning the center focus wheel. Make a note of the diopter setting for your eyes 
for future reference.

EYECUPS	(Figure	�)
Your Bushnell binocular is fitted with rubber roll-down eyecups designed for 
your comfort and to exclude extraneous light. if you wear sun/eyeglasses, roll 
down the eyecups. this will bring your eyes closer to the binocular lens thus 
providing improved field of view.

DiOPtER SEttiNG

Fig.	�

ROLL-DOWN EYECUPS

Fig.	�
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INSTRUCTIONS	FOR	CARE	OF	BINOCUlARS
Your Bushnell binocular will provide years of trouble-free service if it receives the normal care you would 
give any fine optical instrument. the imageview is not waterproof, and should not be exposed to any 
source of moisture. Water damage is not covered by the warranty.

1.  if your binocular has roll-down, flexible eyecups, store it with the eyecups up. this avoids excessive 
stress and wear on the eyecups in the down position.

2.  Avoid banging and dropping.
3.  Store in a cool, dry place.
4.  WARNiNG: Looking directly at the sun with your binocular can cause permanent eye damage.
5.  Never expose your imageView binocular to any type of excessive liquid or fluid, as it is not water/

fogproof.
6.  take the batteries out of your imageView if you are not going to use it for a long period of time. (Make 

sure you download any pictures from your camera before you remove the batteries out of the camera.)

ClEANING
1.  Blow away any dust or debris on the lens (or use a soft lens brush.)
2.  to remove dirt or finger prints, clean with a soft cotton cloth rubbing in a circular motion. Use of 

a coarse cloth or unnecessary rubbing may scratch the lens surface and eventually cause permanent 
damage. A “microfiber” cleaning cloth (available at most photo dealers) is ideal for the routine 
cleaning of your optics.

3.  For a more thorough cleaning, photographic lens tissue and photographic-type lens cleaning fluid 
or isopropyl alcohol may be used. Always apply the fluid to the cleaning cloth – never directly on 
the lens.
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          TWO-YEAR LIMITED WARRANTY
Your Bushnell® product is warranted to be free of defects in materials and workmanship for two years after 
the date of purchase. in the event of a defect under this warranty, we will, at our option, repair or replace 
the product, provided that you return the product postage prepaid. this warranty does not cover damages 
caused by misuse, improper handling, installation, or maintenance provided by someone other than a Bushnell 
Authorized Service Department.
Any return made under this warranty must be accompanied by the items listed below:

 1) A check/money order in the amount of $10.00 to cover the cost of postage and handling
 2) Name and address for product return
 3) An explanation of the defect
 4)   Proof of Date Purchased
 5)  Product should be well packed in a sturdy outside shipping carton, to prevent 
       damage in transit, with return postage prepaid to the address listed below:

 IN U.S.A. Send To:  IN CANADA Send To: 
 Bushnell Outdoor Products Bushnell Performance Optics
 Attn.:  Repairs  Attn.:  Repairs
 8500 Marshall Drive  25A East Pearce Street, Unit 1
 Lenexa, Kansas 66214 Richmond Hill, Ontario L4B 2M9

For products purchased outside the United States or Canada please contact your local dealer for applicable 
warranty information. in Europe you may also contact Bushnell at:  
     Bushnell Germany GmbH
     European Service Center
     Mathias-Brüggen-Str. 80  
     GERMANY  
     D- 50827 Köln
     tel: +49 221 995568-0
     Fax: +49 221 995568-20

this warranty gives you specific legal rights. 
You may have other rights which vary from country to country.

©2007 Bushnell Outdoor Products

FCC	Note:
This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant 
to Part 15 of the FCC Rules. These limits are designed 
to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. if 
this equipment does cause harmful interference to radio 
or television reception, which can be determined by 
turning the equipment off and on, the user is encouraged 
to try to correct the interference by one or more of the 
following measures:
· Reorient or relocate the receiving antenna.
· increase the separation between the equipment and receiver.
· Connect the equipment into an outlet on a circuit  
 different from that to which the receiver is connected. 
· Consult the dealer or an experienced radio/tV  
 technician for help.

The shielded interface cable must be used with the 
equipment in order to comply with the limits for a digital 
device pursuant to Subpart B of Part 15 of FCC Rules.

Specifications and designs are subject to change 
without any notice or obligation on the part of the 
manufacturer. 
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ADVERTENCIA
	 Asegúrese	de	descargar	 las	 fotos	de	 su	cámara	ANTES	de	quitar	o	cambiar	 las	

pilas,	 a	 menos	 que	 haya	 estado	 usando	 una	 tarjeta	 SD	 en	 vez	 de	 la	 memoria	
interna	 para	 almacenar	 las	 fotos.	 Recomendamos	 descargar	 todos	 los	 archivos	
de	 fotos	 actuales	 para	 almacenarlos	 antes	 de	 guardar	 la	 ImageView	 si	 no	 está	
usando	una	tarjeta	SD	en	la	cámara,	en	caso	de	que	las	pilas	se	agoten	durante	el	
almacenamiento	prolongado.

ADVERTENCIA
	 NO	mire	directamente	al	sol	por	los	binoculares.
Al	hacer	esto	se	pueden	causar	daños	permanentes	de	los	ojos.

 
 NOTA: Para reajustar la cámara si tiene problemas o si la pantalla no responde, 

quite las pilas durante al menos un minuto y después vuelva a instalarlas. Esto 
puede resultar en la pérdida de fotos/vídeos guardados en la memoria interna.

Español
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¡Enhorabuena	 por	 la	 compra	 de	 los	 binoculares	 ImageView®	 de	

Bushnell!		los	binoculares	ImageView	de	Bushnell	adopta	la	tecnología	

de	fotografía	digital	y	la	combina	con	unos	binoculares	compactos	de	

alta	calidad.

Esto	permite	observar	acontecimientos	deportivos,	fauna	y	flora,	vistas	

escénicas	o	cualquier	cosa	para	la	que	normalmente	usaría	binoculares	

y	después	guarde	la	imagen	en	una	cámara	digital	conectada	integrada.	

Después	puede	descargar	estas	imágenes	en	su	computadora	y	enviarlas	

por	correo	a	sus	amigos	y	familia,	imprimir	la	foto	usando	el	software	

incluido	 o	 guardarlas	 en	 un	 álbum	 de	 fotos	 para	 uso	 futuro.	 Antes	

de	 usar	 el	 producto,	 lea	 las	 instrucciones	 contenidas	 en	 este	 manual	

y	 tómese	 el	 tiempo	 para	 familiarizarse	 con	 las	 diferentes	 piezas	 y	

características	del	producto.
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Guía	de	piezas	de	la	cámara	
y	de	los	binoculares

(ábralo deslizando 
en sentido de la 
flecha)

Receptáculo 
del trípode

Compartimiento 
de las pilas

Puerto 
de USB

Jack 
remoto

Ranura de 
la tarjeta

LED de 
encendido

Lente de la 
cámara

Foco de los 
binoculares

Botón de modalidad/
encendido

Botón Snap 
(instantáneas)

Pantalla 
LCD
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CAMERA PARTS
1. La cámara está alimentada por dos pilas AAA alcalinas de litio o NiMh (no incluidas).
introduzca las pilas en el comportamiento, con los resortes en contacto con el extremo negativo 
(plano) de cada pila. El medidor de corriente de la parte inferior derecha de la pantalla indica la 
condición de las pilas.
2. introduzca una tarjeta SD (“boca abajo” con los contactos de metal apuntando hacia arriba) 
en la ranura si se desea un mayor almacenamiento. Puede usar tarjetas SD (no tarjetas MMC) 
hasta una capacidad máxima de 1 GB. La cámara tiene una memoria interna de 16 MB que 
pueden contener más de 100 fotos, por lo que tal vez una tarjeta no sea necesaria. No obstante, 
se perderá el contenido de la memoria interna si se sacan las pilas o se agotan, a diferencia de las 
fotos almacenadas en una tarjeta de memoria SD. Se dispone de una tarjeta SD de velocidad 
estándar de 256MB, 512 MB o 1GB en la mayoría de las tiendas de componentes electrónicos 
del consumidor o de computadoras y es una buena opción para su imageView, especialmente si 
va a usar siempre una “alta” resolución.
3. Pulse sin soltar el botón MODE (modalidad) hasta que se encienda el LED de encendido. La 
cámara se apagará automáticamente después de un minuto si no se pulsa ningún botón. Nota: 
cuando la cámara esté conectada a una computadora por medio de un cable USB suministrado, la 
cámara se encenderá automáticamente y absorberá corriente de la computadora sin drenar las pilas
4. Mantenga fija la imageView y pulse SNAP para tomar una foto (o iniciar/detener un vídeo, 
cuando la cámara esté en la modalidad de vídeo). El foco de la cámara está prefijado para tomar 
fotos nítidas desde aproximadamente 10,5 m hasta el infinito.
5. Cuando se use un trípode, puede ayudar a evitar los efectos de movimiento de la cámara 
enchufando el dispositivo de desconexión del obturador remoto en el jack junto a la ranura de la 
tarjeta SD, y usando el botón del control remoto en vez de SNAP para tomar las fotos.

Configuración	y	operación	básica
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La imageView imprimirá la fecha y la hora en la esquina inferior derecha de sus fotos. Para fijar 
la fecha y la hora correctas, después de encender la cámara, pulse sin soltar los botones MODE 
y SNAP al mismo tiempo, hasta que empiece a destellar la pantalla. La pantalla muestra ahora 
los dos últimos dígitos del año. Pulse el botón MODE para mover el cursor al segundo dígito 
si es necesario. Pulse el botón SNAP para hacer avanzar el dígito al año actual (“07” para 2007, 
etc).
Después pulse MODE para ir al siguiente número, que es el mes. Nuevamente, use SNAP 
para cambiar esto al mes actual. Después de la visualización del mes aparecen: fecha, hora 
(formato de 24 horas), minutos y segundos. Continúe fijando éstos siguiendo el mismo 
proceso usando los botones MODE y después SNAP. Cuando haya completado todos los 
ajustes de fecha/hora, la pantalla dejará de destellar y volverá a ser normal. Observe que tendrá 
que reajustar la fecha/hora después de reemplazar las pilas. Su imageView ya está fijada para 
una alta resolución y alta calidad justo después de sacarla de la caja, y no es necesario usar los 
ajustes MODE y efectuar cambios para obtener los buenos resultados pulsando simplemente el 
botón SNAP para tomar fotos. Sin embargo, como tal vez desee filmar un clip de vídeo, borrar 
una o más fotos anteriores o explorar otras opciones, recomendamos que revise las opciones 
de modalidad disponibles indicadas en las páginas siguientes. Al pulsar brevemente el botón 
MODE se recorrerán estas modalidades de operación en el orden indicado, y se verá el icono de 
cada modalidad junto con su ajuste actual en la pantalla. Use el botón SNAP para seleccionar 
el ajuste deseado para cualquier modalidad. Si no efectúa ningún cambio, y no se pulsan los 
botones SNAP o MODE en un plazo máximo de 5 segundos, la cámara volverá a la operación 
y pantalla normales.

Uso	de	las	modalidades	de	operación/Ajuste	de	la	fecha	y	de	la	hora
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Uso	de	las	modalidades	de	operación	(negrita	indica los ajustes implícitos)
Modalidad Icono Ajustes Descripción

Vídeo Cámara de 
vídeo

OFF (apagado), 
ON (encendido)

Seleccione “ON” en vez de “OFF” para poner 
la cámara en la modalidad de vídeo. Espere 
varios segundos para que la cámara vuelva 
automáticamente a la pantalla normal, y después 
empiece a filmar pulsando SNAP.
El contador mostrará el tiempo transcurrido. 
Pulse SNAP otra vez para dejar de filmar. El 
contador avanzará de uno en uno, indicando 
que el archivo de vídeo se ha guardado. Vuelva 
al ajuste de la modalidad de vídeo y seleccione 
OFF para reajustar la cámara a la modalidad de 
foto fija.

Calidad Hq (alta 
calidad) 
o Lq (baja 
calidad)

High (alta), 
Low (baja)

Seleccione calidad “Hi” (recomendado) o “Lo” 
para escoger la cantidad de compresión de 
archivos, lo que afecta el tamaño del archivo de 
fotos.  “Lo” permite almacenar más fotos en la 
memoria, pero con una calidad reducida.

Resolución Hi (alta) o 
Lo (baja)

High (alta) 
(2.1mega pixels), 
Low (baja) 
(640x480 pixels)

Seleccione resolución “Hi” (recomendada) o 
“Lo”, basándose en su preferencia para obtener 
fotos de mejor aspecto (Hi) o poder tomar un 
mayor número de fotos (Lo).
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Modalidad Icono Ajustes Descripción

Frecuencia 
de la línea

60 ó 50 60 Hz, 50 Hz Fije para hacer corresponder con la frecuencia de CA 
(ciclos) de su país. Esto asegura que las fotos fijas 
y los vídeos filmados con luz fluorescente aparezcan 
normales.

Continua Ct OFF (apagado, 
3, 5

Seleccione 3 ó 5 cuadros para tomar una serie rápida 
de fotos en vez de un solo cuadro cuando se pulse 
SNAP (en la modalidad de foto fija normal) Para 
cancelar, entre en esta modalidad nuevamente y 
seleccione OFF. 

Acceso de 
memoria

MEM Sto 
(almacenamiento 
en masa USB), 
PC (cámara 
USB)

Seleccione “Sto” para tener acceso a la memoria 
interna o de la tarjeta cuando la cámara esté conectada 
a una computadora con el cable USB. “PC” permite 
usar la cámara como una cámara USB/PC en directo 
(observe que los 8 aumentos y la falta de capacidad 
de enfoque cercano limita su utilidad en la mayoría 
de las habitaciones)

Borrar 
último

LSt +trash 
Can 
(último
+basurero)

Ninguno-pulse 
SNAP para 
borrar la última 
foto o el último 
vídeo

Seleccione esta modalidad y pulse SNAP para borrar 
solamente la última foto tomada o el último vídeo 
filmado. El contador se reducirá en un número.

Uso	de	las	modalidades	de	operación	(negrita	indica los ajustes implícitos)
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Modalidad Icono Ajustes Descripción

Borrar todo ALL+trash 
Can 
(todo
+basurero)

Ninguno-
pulse SNAP 
para borrar 
todos los 
archivos de 
fotos y vídeos

Seleccione esta modalidad y pulse SNAP para borrar 
todo el contenido de la memoria (el contador se 
reajusta a cero). Use esto después de descargar los 
archivos, para borrar la memoria de modo que pueda 
tomar nuevas fotos. Si se selecciona “Delete All” de 
forma involuntaria. Simplemente espere unos segundos 
y la cámara volverá a la operación normal.

Formato For+trash 
Can
 (formato
+basurero)

Ninguno-
pulse SNAP 
para formatear 
la tarjeta o 
la memoria 
interna

Si está usando una nueva tarjeta SD, o una previamente 
usada en otros dispositivos, recomendamos que 
seleccione Format y pulse SNAP antes de empezar a 
tomar fotos, de modo que la tarjeta está configurada 
con el archivo de datos correctos para esta cámara. 
Observe que el formateo de una tarjeta borra su contenido, 
por lo que debe asegurarse de copiar primero los archivos 
anteriores.

tempo-
rizador 
automático

Clock 
(Reloj)

OFF 
(apagado) 
o On 
(encendido)

La foto se toma después de una demora de 10 segundos 
después de pulsar SNAP (en la modalidad de fotos fijas 
normal). Esto se puede usar para no mover la cámara 
por accidente cuando se pulse el botón SNAP. Si se 
dispone del cable del obturador remoto, se debe usar 
en vez del temporizador automático cuando la cámara 
esté montada en un trípode. El temporizador se cancela 
de forma automática después de usarse.

Uso	de	las	modalidades	de	operación	(negrita	indica los ajustes implícitos)

ImageView 118322 English+Spanish25   25 11/13/07   8:06:44 PM



��

USO DE iMAGEViEW CON SU COMPUtADORA:

1.  La cámara será reconocida como un dispositivo de almacenamiento en masa USB (si se fija en “StO” 
y no en “PC”), lo que significa que no se necesitan controladores especiales para todos los sistemas de 
operación posteriores a Windows 98 (Me, 2000, XP, Vista). Mac OS 9 y OSX también son compatibles. 
Si tiene una PC que funciona con Windows 98, debe instalar el controlador encontrado en el CD-ROM 
incluido ANtES DE CONECtAR LA CÁMARA A SU PC.

�.  Si tiene una computadora OS como la indicada arriba que cumpla con el almacenamiento en masa USB, 
aparecerá un nuevo icono de disco en Windows Explorer (en “Mi PC”) como nuevo “Disco extraíble” 
después de enchufar el cable USB de imageview. Los usuarios de Mac verán aparecer el nuevo dispositivo 
de disco en su escritorio.

    Al hacer clic en el nuevo icono de disco se mostrará el contenido, una carpeta llamada “DCiM”. La 
carpeta de imágenes de dentro contiene sus fotos, almacenadas en forma JPEG (formato de archivo .jpg). 
Se pueden ver, modificar, cambiar de nombre y guardar usando cualquier software de fotos o gráficos 
que acepte archivos .jpg. Si no tiene software que abra los archivos .jpg, debe instalar Roxio Photosuite 
5 (Windows 98, 2000 ó XP solamente) del CD-ROM incluido. Vea las instrucciones en “instalación 
del software”.

�. Después de haber copiado o abierto y guardado los archivos de fotos en la unidad de disco de su 
computadora, puede desconectar la cámara imageview (no desconecte NUNCA la cámara mientras se 
estén transfiriendo los archivos a su computadora). Antes de desconectar, debe “expulsar” o detener el 
“disco extraíble” que representa la cámara para evitar un mensaje de error (no es necesario con Windows 
XP). 

�. Vea en las páginas siguientes las instrucciones paso a paso para descargar sus fotos.
PRECAUCIÓN:	Asegúrese	de	descargar	todas	las	fotos/vídeos	de	la	
memoria	interna	de	su	cámara	antes	de	quitar	las	pilas.
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Requisitos del sistema (mínimo)

Instalación del software 

Transferencia de fotos y vídeos a su PC – Paso a paso

OS: Windows® 98/98SE/2000/ME/XP/Vista (PhotoSuite 5 no es compatible con Vista)
CPU: MMX Pentium® 200MHZ equivalente o más rápido (Pentium® iii 500 MHz para PhotoSuite5™)
Memoria: 32MB mínimo (64MB recomendada para PhotoSuite)
tarjeta de vídeo SVGA con 2MB de VRAM, pantalla de 800x600, color 16 bit High 
Espacio de disco duro disponible de 200 MB (si se instala PhotoSuite)
Puerto USB interno

Si está usando Windows 98, debe instalar controladores antes de conectar la cámara a su PC. introduzca el 
CD-ROM en la unidad de CD de su computadora; se ejecutará automáticamente y se mostrará la pantalla de 
instalación. Seleccione “instalar controlador”, y después siga las instrucciones. Después de la instalación, vuelva a 
iniciar su computadora. Windows 2000, ME y XP no requieren controladores, ya que la cámara usa la norma de 
almacenamiento en masa USB, permitiendo el acceso a los archivos de fotos como si estuvieran almacenadas en un 
disco duro externo. Para cualquier Windows OS, si aún no está usando su software de edición de fotos preferido, 
puede instalar Roxio PhotoSuite® del CD-ROM. Asegúrese de leer las “Notas de publicación” completamente, 
observando cualquier recomendación o temas potenciales para la configuración de su PC y OS.

1. Asegúrese de que se haya instalado primero el controlador si está usando Windows 98/98SE.
�. Conecte el cable incluido al puerto USB de imageView, y después directamente a un puerto principal de USB 
de su computadora sin usar los puertos USB del panel frontal/teclado o concentradores sin conectar.

Nota: Con Windows Vista, puede encontrar mensajes de error o advertencia (“falta un 
archivo”, etc) durante la instalación de PhotoSuite 5, pero al hacer clic en “OK” y seguir 
adelante se debe permitir terminar la instalación.

ImageView 118322 English+Spanish27   27 11/13/07   8:06:44 PM



��

Transferencia de fotos y vídeos a su PC (continuación)
�. La pantalla LCD indicará “StO” y la imageView será reconocida como un dispositivo estándar de 
“almacenamiento en masa USB”. Esto significa que los archivos de la cámara se pueden ver, modificar 
o copiar fácilmente en su disco duro, simplemente como si se guardaran en un disco duro externo o 
un CD-ROM. (Nota para los usuarios de Mac: tal vez sea necesario seleccionar el acceso de memoria 
“StO” y enchufar la imageView mientras su LCD siga mostrando “StO” para que aparezca en el 
escritorio de Mac como un disco “Sin título”. Vea “Uso de las modalidades de operación”)
�. (Este paso no es necesario con Windows XP, use simplemente las opciones de la ventana emergente 
para ver, copiar o modificar sus fotos). Abra Mi PC o Windows Explorer. La cámara se verá como un 
nuevo “Disco extraíble” con una letra de unidad de disco sin usar asignada a la misma. Haga doble clic 
en este nuevo icono “Disco”, abra la carpeta “DCiM” de dentro, y después las carpetas de dentro de ésta 
(“100MEDiA”, etc). Sus fotos/vídeos son los archivos de dentro, que tienen el prefijo “DSC” seguido 
por un número de 4 dígitos, según se ha visto antes en la pantalla de la cámara al revisar las fotos. Al 
hacer clic en un solo archivo se debe mostrar una pequeña imagen preliminar.
�. Haga clic en “Modificar>Seleccionar todo” (o haga clic en una foto, control+clic para seleccionar 
múltiples fotos) y después “Modificar>Copiar a la carpeta” (en los menús de Windows). Seleccione una 
carpeta existente en su disco duro, como “Mis fotos”, o cree una nueva carpeta (“Vacaciones en Hawai”, 
etc) y después haga clic en “OK” para transferir las copias de los archivos de fotos que desee.
�. Después de haber transferido las fotos a su disco duro, puede desconectar la cámara. Windows 2000 
puede producir una advertencia de pantalla indicando que ha desconectado un dispositivo USB sin 
detener o expulsar el “disco” primero (sus archivos de fotos no resultarán dañados). Si es así, marque 
el cuadro que añade un icono a su bandeja del sistema o barra de tareas. Después, la próxima vez 
que termine de transferir las fotos, puede hacer clic en ese icono primero y “Parar el dispositivo de 
almacenamiento en masa USB” antes de desconectar la cámara. (En las computadoras Mac, debe 
“expulsar” el “disco” sin título que apareció en su escritorio cuando la cámara estaba conectada).
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Transferencia de fotos y vídeos a su PC (continuación)
�. Ahora está listo para abrir los archivos de fotos en cualquier software de edición de fotos. Simplemente 
use Archivo>Abrir y vaya a la carpeta donde almacenó las fotos antes. Si está usando PhotoSuite, 
seleccione Archivo>Abrir foto y después use el menú desplegable “Buscar en” de la parte superior de la 
ventana Abrir, seleccione “Mi PC”, seleccione su disco duro y haga doble clic en cualquier foto de la 
carpeta donde haya copiado los archivos de la cámara. también es posible abrir y trabajar con sus fotos 
directamente desde la imageView mientras esté conectada. Para hacer esto con PhotoSuite, primero 
siga los pasos 1-3, después abra PhotoSuite, seleccione Archivo>Abrir foto y use el menú “Buscar en” 
para seleccionar Mi PC, después seleccione el “Disco extraíble” y abra las carpetas de dentro hasta que 
obtenga los archivos de fotos JPEG. Si decide trabajar de esta forma, desde una cámara conectada, 
asegúrese de guardar la foto (cuando haya terminado de modificarla) en su disco duro y no en la memoria 
o en la tarjeta de la cámara. Para hacer esto en PhotoSuite, después de hacer clic en “Hecho”, responda 
a “¿Guardar cambios?” con “Sí”, pero después conteste “¿Desea reemplazar el archivo existente”? con 
“No” y use el cuadro de diálogo “Guardar como” para guardar la foto modificada en una carpeta de su 
disco duro (“Guardar en>Disco local”), no en “Disco extraíble” (cámara).
�. Si usted es nuevo en la edición de fotos en una computadora, consulte en su menú de Ayuda 
del software (PhotoSuite tiene una Ayuda integrada extensiva) recomendaciones sobre el uso de sus 
características. Además de ajustar el brillo, el contraste, la nitidez y el color de sus fotos, se puede 
cambiar el tamaño de la foto para adaptarse al papel si está imprimiendo, o guardar una versión de 
resolución más pequeña, baja o intermedia para correo electrónico o insertar en documentos. Cuando 
esté listo para guardar su archivo modificado, puede usar “Guardar como” y darle un nombre más 
descriptivo que “DSC___”. Al hacer esto también se preserva el archivo original como reserva para 
volver a abrirlo y modificarlo más adelante. Asegúrese de haber transferido con éxito todas las fotos 
deseadas para guardarlas antes de usar “Borrar todo” en su cámara y dejar sitio a nuevas imágenes.
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Sus binoculares Bushnell son un instrumento de precisión para darle muchos años de visión 
agradable. Esta parte del librito le ayudará a lograr el rendimiento óptimo explicando cómo 
pueden ajustarse los binoculares a sus ojos, y cómo cuidar este instrumento. Lea detenidamente 
las instrucciones antes de usar los binoculares.

AJUSTES	DE	lOS	OJOS	(Figura	1)
Cómo	ajustar	la	distancia	entre	los	ojos
La distancia entre los ojos, llamada distancia “interpupilar”, varía 
de una persona a otra. Siga estos pasos sencillos para lograr un 
alineamiento perfecto de la lente con los ojos.

1. Sujete los binoculares en la posición de observación normal.
2. Sujete firmemente cada cilindro. Acerque o separe los cilindros hasta que vea un solo 
campo circular. Reajuste siempre sus binoculares a esta posición antes de usarlos.

Cómo ajustar según la intensidad de la visión
Como la vista varía de una persona a otra, la mayoría de los binoculares de Bushnell tienen una 
característica de ajuste dióptrico que permite ajustar con precisión los binoculares a su visión. 
Siga las instrucciones de enfoque siguientes para su tipo de binoculares.

ENFOQUE
1. Ajuste la distancia interpupilar. (Figura 1)
2. Fije el “ajuste dióptrico” (Figura 2) en cero y observe un objeto distante.

INSTRUCCIONES	PARA	lOS	BINOCUlARES

Fig.	1

DiStANCiA  iNtERPUPiLAR
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3. Mantenga abiertos los ojos en todo momento.
4. Usando una tapa de lente en la mano, cubra el objetivo 
(delantero) del mismo lado de los binoculares que tenga el “ajuste 
dióptrico”. Esto es normalmente el lado derecho. (El lado izquierdo 
en los modelos con aumentos).
5. Use la perilla de enfoque central para enfocar un objeto distante 
con detalle de precisión (por ejemplo, muro de ladrillo, ramas de 
árbol, etc.) hasta que aparezca tan nítido como sea posible.
6. Destape el objetivo en el lado dióptrico, tape el otro objetivo y después observe el mismo 
objeto.
7. Enfoque el mismo objeto observado usando el anillo de “ajuste dióptrico”. Se debe tener 
cuidado, ya que al girar o forzar el ocular dióptrico se pueden producir daños o hacer que 
el ocular se desprenda del chasis.
8. Los binoculares deben ajustarse a sus ojos. El enfoque a cualquier distancia lejana o 
cercana se puede lograr ahora simplemente girando la rueda de enfoque central. Anote el 
ajuste dióptrico para sus ojos como futura referencia.

OJERAS	(Figura	�)
Sus binoculares Bushnell disponen de ojeras de goma diseñadas para 
su comodidad y para excluir luz extraña. Si lleva gafas normales o de 
sol, enrolle hacia abajo las ojeras. Esto le permitirá acercar los ojos a las 
lentes de los binoculares, mejorando así su campo de visión. OJERAS DE DiSEñADAS

Fig.	�

AJUStE DióPtRiCO

Fig.	�
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INSTRUCCIONES	PARA	El	CUIDADO	DE	lOS	BINOCUlARES
Sus binoculares Bushnell proporcionarán años de servicio sin problemas si reciben el cuidado normal que les 
daría a cualquier instrumento óptico preciso. Los imageView no son impermeables, y no deben exponerse a 
ninguna fuente de humedad. Los daños causados por el agua no están cubiertos por la garantía.

1. Si sus binoculares tienen ojeras enrollables hacia abajo flexibles, guárdelos con las ojeras hacia arriba. 
Esto evita una fatiga y un desgaste excesivos en las ojeras en la posición bajada. 
2. Evite los golpes y las caídas.
3. Guarde en un lugar fresco y seco.
4. ADVERTENCIA: Mirar directamente al sol con los binoculares puede causar daños permanentes en 
los ojos.
5. No exponga nunca sus binoculares imageView a ningún tipo de líquido o fluido excesivos, ya que no 
son a prueba de agua o neblina.
6. Saque las pilas de su imageView si no va a usarlos durante un largo tiempo. (Asegúrese de descargar las 
fotos de su cámara antes de sacar las pilas de la misma).

lIMPIEZA
1. Retire el polvo o los residuos de la lente soplando (o use un cepillo suave para lentes).
2. Para quitar el polvo o las marcas de los dedos, limpie con un paño de algodón suave frotando en 
movimiento circular. El uso de un paño tosco o un forzado innecesario puede rayar la superficie de la 
lente y con el tiempo producir daños permanentes. Un paño de limpieza de “microfibras” (disponible en 
la mayoría de los distribuidores de fotos) es ideal para la limpieza rutinaria de su sistema óptico.
3. Para efectuar una limpieza más completa, se pueden usar papeles y fluido de limpieza para lentes 
fotográficas o alcohol isopropílico. Aplique siempre fluido al paño de limpieza – nunca directamente 
en la lente.
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GARANTÍA LIMITADA de DOS AñOS

Su producto Bushnell está garantizado contra defectos de materiales y fabricación durante 
dos años después de la fecha de compra. En caso de defectos bajo esta garantía, nosotros, 
a nuestra opción, repararemos o sustituiremos el producto siempre que lo devuelva con 
portes pagados. Esta garantía no cubre defectos causados por el uso indebido, ni por un 
manejo, instalación o mantenimiento realizados por alguien que no sea un departamento 
de servicio autorizado de Bushnell.
Cualquier envío que se haga bajo esta garantía deberá ir acompañado por lo siguiente:
 
 1) Un cheque/giro postal por la cantidad de 10 dólares para cubrir los gastos postales y de manejo
 2) Nombre y dirección donde quiere que se le envíe el producto
 3) Una explicación del defecto
 4) Una prueba de la fecha de compra
 5) El producto debe empaquetarse bien en una caja resistente para evitar que se dañe durante el  
  transporte, con los portes prepagados a la direcciÛn que se muestra a continuación:

En EE.UU. enviar a:  En CANADÁ enviar a:   
Bushnell Outdoor Products  Bushnell Outdoor Products
Attn.:  Repairs   Attn.:  Repairs
8500 Marshall Drive  25A East Pearce Street, Unit 1
Lenexa, Kansas 66214  Richmond Hill, Ontario L4B 2M9

En el caso de productos comprados fuera de Estados Unidos o Canadá, póngase en con-
tacto con su distribuidor local para que le den la información pertinente sobre la garantía. 
En Europa también puede ponerse en contacto con Bushnell en:  
 
   Bushnell Germany GmbH

      European Service Center
      Mathias-Brüggen-Str. 80  
      GERMANY   
      D- 50827 Köln
      Tel: +49 221 995568-0

   Fax: +49 221 995568-20

Esta garantía le ofrece derechos legales específicos. 
Puede que tenga otros derechos que varían de un país a otro. 
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Nota de la FCC:
Este equipo ha sido sometido a pruebas y cumple con 
los límites establecidos para un aparato digital de Clase 
B, de acuerdo con la Parte 15 del Reglamento de la 
FCC. Estos límites están diseñados para proporcionar 
protección razonable contra interferencias perjudiciales 
en una instalación residencial. Este equipo genera, 
emplea y puede irradiar energía de radiofrecuencia 
y, si no se instalada y utiliza de acuerdo con las 
instrucciones, puede causar interferencia perjudicial a 
las radiocomunicaciones. Sin embargo, no garantizamos 
que no ocurrirán interferencias en una instalación 
en particular. Si este equipo causa interferencias 
perjudiciales a la recepción radial o televisiva, situación 
que puede determinarse apagando y encendiendo el 
equipo, se sugiere al usuario que trate de corregir tal 
interferencia mediante uno o más de las siguientes 
medidas:
· Reorientar o relocalizar la antena receptora.
· Incrementar la separación entre el equipo y el receptor.
· Conectar el equipo a un tomacorriente en un circuito 
diferente al que está conectado el receptor. 

· Consultar con el concesionario o un técnico 
experimentado en radio/televisión solicitándole 
asistencia.

Con este equipo se debe usar un cable de interfaz 
blindado para cumplir con los límites para un aparato 
digital de acuerdo con la Subparte B de la Parte 15 del 
Reglamento de la FCC.

Las especificaciones y diseños están sujetos a cambios sin ningún aviso u obligación por parte del fabricante.  
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For further questions or additional information please contact:

Bushnell Outdoor Products
9200 Cody, Overland Park, Kansas 66214

(800) 423-3537  •  www.bushnell.com
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